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Introduction

in this section

• Purpose of This Manual

• The Role of the Church Administrator

• Church Structure

• Basic Information About the Church
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Office Procedures

Purpose of This Manual

This manual explains the basic and essential tasks needed to for the All 
Pilgrims Christian Church office to run smoothly. It is intended as a 
training tool and also as a quick reference for the following audiences:

• A newly hired Church Administrator.

• A temporary administrator covering vacations or sickness.

• A staff, committee, or church member who needs to accomplish 
a specific task.

The Role of the Church Administrator

The church office is the hub of All Pilgrims Christian Church (APCC) 
and is where information is centralized and where communication 
begins.The role of Church Administrator is varied and includes the fol-
lowing tasks:

• Assist the pastors, committees, and staff with administrative 
tasks.

• Field inquires from potential renters regarding building use.

• Answer phones, respond to email and voicemail.

• Publish monthly newsletter and weekly worship bulletin.

Many office tasks recur on a daily, weekly, or monthly basis. For a list of 
these tasks, see Appendix A: Recurring Office Tasks.
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Church Structure

All Pilgrims Christian Church is made up of:

• Membership.

• Coordinating Council.

• Committees.

• Staff.

• Clusters.

Membership
The membership at All Pilgrims Christian Church is divided into four 
categories:

1. Active member.

2. Ecumenical colleague.

3. Associate member.

4. Inactive members.

Membership information is stored in the Servant Keeper database. For 
information and instructions on Servant Keeper, see the following file:

office/procedures/sk/sk_manual.pdf

Coordinating Council and Committees
The Coordinating Council is the governing body of the church. It con-
sists of the Moderator, the Moderator-Elect, the Co-Pastors, and the 
Chairs of the following committees:

• Building & Grounds.

• Congregational Care.

• Children and Youth.

• Endowments & Special Gifts.

• Finance.

• Music and Worship.

• Outreach and Mission.

• Personnel.

Staff
All Pilgrims employs the following staff members:

• Co-Pastors.

• Music Director.

• Church Administrator.

• Live-in Caretaker.

• Seminary Intern.
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Clusters
A cluster is a group of up to twenty people from among the members and 
friends of All Pilgrims. Clusters are designed to promote social activities 
among the congregation.

Some activities of the cluster will be service within the congregation e.g. 
serving together on a Sunday morning or hosting a potluck gathering. 
Some activities will be outside the congregation e.g. a Habitat for 
Humanity project or a peace vigil. Some activities will emerge from the 
expressed desire of your cluster like a nature hike, or a book-study with a 
pastor).

Basic Information About the Church

This section lists basic contact information for the church office and key 
staff members.

Mailing address
All Pilgrims Christian Church
500 Broadway East
Seattle, WA 98102

Telephone and fax numbers

Email addresses

Web addresses

* The meeting minutes site lists recent minutes from various commit-
tees.It is only advertised to the congregation and is not directly accessible 
from the main website.

Church Office 206.322.0487

Rev. Peter Drury 206.322.0488

Rev. Mark Travis 206.322.3003

Office Fax 206.322.0489

Church Office office@allpilgrims.org

Rev. Peter Drury peter@allpilgrims.org

Rev. Mark Travis mark@allpilgrims.org

Church website www.allpilgrims.org

All Pilgrims Concert Series www.allpilgrims.org/apcs

APCC meeting minutes* www.allpilgrims.org/minutes



Fo
r D

em
on

st
ra

tio
n 

Pu
rp

os
es

 O
nl

y



Fo
r D

em
on

st
ra

tio
n 

Pu
rp

os
es

 O
nl

y

Telephone and Fax

in this section

• Answering the Phone

• Using Voicemail

• Sending and Receiving Faxes
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Office Procedures

Answering the Phone

The church office is usually the first point of contact for people calling by 
telephone. It is important to convey a friendly, professional attitude when 
answering the phone.

Calls may come in on a variety of different topics including:

• Inquiries about the church and its activities.

• Inquiries from potential renters regarding price and availability.

• Requests for information or action from staff, committee, or 
church members.

If you are not able to answer the person's inquiry or request, you may 
need to take a message or refer them to one of the Co-Pastors or commit-
tee members.

For a list of frequently used contacts, consult the following file:

office/labels and lists/lists/fun.doc

Using Voicemail

If someone calls and you are not able to answer, they may leave a voice-
mail message. The church's voicemail is provided by Qwest and can be 
accessed from any touch-tone phone. If there are messages waiting to be 
retrieved, you will hear a series of short beeps when you pick up the 
phone.

Besides simply listening to messages, there are a number of other tasks 
you can perform using the voicemail system, including:

• Saving and deleting messages.

• Forwarding messages.

• Changing the voicemail greeting.

To listen to voicemail messages

1. Pick up the phone and dial 322.1234.

2. When prompted, enter the password 5009. New messages will 
begin playing automatically.
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Once you are listening to messages, you can perform additional task as 
listed below.

To save voicemail messages

1. Press 3 3 to jump to the end of the message.

2. Press 9 to save.

To delete voicemail messages

1. Press 3 3 to jump to the end of the message.

2. Press 7 to delete.

To forward voicemail messages

1. Press 3 3 to jump to the end of the message.

1. Press 6 to forward.

2. At the prompt, record an introductory message then press #.

3. Enter the telephone number of the recipient and press #.

4. Repeat step 3 for any additional recipients.

5. Press * to forward the message.

Note: you can only forward messages to other Qwest telephone num-
bers.

The voicemail greeting
There are two different greetings available on the voicemail system: the 
standard greeting and the extended absence greeting. The standard greet-
ing is heard by all callers who are transferred to voicemail. The extended 
absence greeting can override the standard greeting if you need to make 
minor temporary changes to the greeting content.

Whether the system is configured to play the standard or extended 
absence greeting, you must always include the following information:

• Church address.

• Church office hours.

• Worship times.

• Contact information for the pastors.

Consult the Co-Pastors to find out if they require additional information 
in the greeting. For an example of the current greeting, see the following 
file:

office/documentation/phone_greeting.doc
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To change the standard greeting

1. Pick up the phone and dial 322.1234.

2. When prompted, enter the password 5009.

3. Press 4 3 1.

4. When prompted, record your greeting.then press #.

5. Press * to rerecord your greeting or # to finish.

6. Hang up the phone.

To change the extended absence greeting

1. Pick up the phone and dial 322.1234.

2. When prompted, enter the password 5009.

3. Press 4 3 2.

4. When prompted, record your greeting.then press #.

5. Press * to rerecord your greeting or # to finish.

6. Hang up the phone.

Sending and Receiving Faxes

The church has two fax machines: one in the church office and one in 
the Chalice Room.

To send a fax
Both machines operate in the same way.

1. Place the document face down on the document feeder.

2. Press the Monitor button and listen for the dial tone.

3. Dial the recipient's fax number using the keypad.

4. When the recipient's fax picks up, press the Start/Send button.

Note: if you are sending using the fax in the Chalice Room, you must 
feed the pages through manually, one at a time.

To receive a fax
The fax in the Chalice room should be set up to receive faxes automati-
cally. The LCD display will point to Fax if it is set up correctly. As long 
as there is enough paper in it, you do not need to adjust it in any way. If it 
is not set up correctly, press the Mode button until the LCD display 
points to Fax.

The fax in the church office is connected to the office telephone line and 
is not set up to receive faxes automatically. If you want to receive a fax in 
the church office, you must press the Mode button until the LCD dis-
plays points to Fax.
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Internet and Email

in this section

• Connecting to the Internet

• Using Email

• Troubleshooting Problems
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Connecting to the Internet

The church connects to the Internet using a digital subscriber line (DSL) 
provided by Earthlink. This type of connection is “always on” meaning 
that you should always be able to access the Internet without having to 
make a connection or interrupting the phone line.

The DSL connection is routed to a local area network that extends the 
connection capabilities to most other rooms in the building.

Using Email

All the email accounts provided to church staff and others are created 
and administered through the church's Web hosting service, and are in 
the format name@allpilgrims.org. For a more detailed discussion of the 
Web hosting service, refer to  “All Pilgrims’ Website” on page17.

You can access your email account by using a Web browser or by config-
uring an email program such as Outlook.

To check email using a Web browser

1. Open a Web browser and got to webmail.netfirms.com.

2. Enter your email address and password.

3. Click Login.

To configure an email program
The following instructions apply to Outlook and Outlook Express. Most 
other email programs have similar set up procedures, but please see your 
program documentation for specific details.

1. Open Outlook.

2. From the Tools menu, click Accounts.

3. Click New, then Mail.

4. Complete the on-screen wizard using the following information:
• Email address: your email address
• Mail server type: POP3
• Incoming mail server: popmail.allpilgrims.org
• Outgoing mail server: smtp.allpilgrims.org
• Username: your email address
• Password: your password
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Troubleshooting Problems

The following table lists common problems and solutions associated 
with Internet access and email.

Problem Possible Cause Solution

My computer won’t 
connect to the Inter-
net.

The network equip-
ment has temporarily 
stalled.

Turn off your com-
puter, the DSL 
modem, and the 
router. Then turn 
everything back on.

The connection to 
the ISP has been 
dropped.

Reboot your com-
puter.

My password 
doesn’t work when I 
check email with a 
browser.

You made an typing 
error.

Check also that 
Caps-Lock is turned 
off and retype your 
account information.

You are on the 
wrong screen.

Check that you are at 
webmail.net-
firms.com.

The messages in my 
Outlook Inbox are 
not visible when I 
check email with a 
browser.

Outlook has been set 
up to remove mes-
sages from the server.

Open Outlook and 
from the Tools  
menu, click 
Accounts. Double-
click the account you 
want to work with 
then, on the 
Advanced tab, select 
Leave a copy of mes-
sage on server.

Outlook displays a 
Mail Delivery Error

You are not con-
nected to the Inter-
net.

Check the network 
connections and the 
computer’s network 
settings. Turn the 
equipment off and 
on.

There is a temporary 
problem with the 
server.

Try again later or 
check email with a 
browser.
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All Pilgrims’ Website
in this section

• Introduction

• Adding, Updating, and Deleting Pages

• Website Account Maintenance

• Troubleshooting Problems
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Introduction

All Pilgrims’ website address is www.allpilgrims.org. The website is 
hosted by Netfirms and contains the following features:

• 500 MB storage space.

• 10 GB transfer per month.

• 100 email addresses.

• 2 MySQL databases.

Adding, Updating, and Deleting Pages

To change existing pages on the website or to create new pages, you must 
first make the desired changes on the office computer. Once you have 
made these changes, you must upload the pages to the server using an 
FTP program.

To create a new page
The following steps assume the user knows HTML.

1. Click Start, point to Web Tools and choose HTML Validator.

2. From the File menu, click Open.

3. Locate and double-click the following file:

office/websites/APCC/template.html

This file contains the necessary code to produce a blank page 
using the All Pilgrims website design.

4. Make the desired additions and changes.

5. From the File menu, click Save As.

6. Type the desired name in the File Name box and click Save.

To change an existing page
The following steps assume the user knows HTML.

1. Click Start, point to Web Tools and choose HTML Validator.

2. From the File menu, click Open.

3. Locate and double-click the file you want to change.

4. Make the desired additions and changes.

5. From the File menu, click Save.



Fo
r D

em
on

st
ra

tio
n 

Pu
rp

os
es

 O
nl

y

20 | All Pilgrims’ Website

Office Procedures

To upload a page to the server

1. Click Start, point to Web Programs and choose FTP.

2. From the Profile Name  drop-down menu, click All Pilgrims.

3. Click Connect.

4. On the Remote System screen (right side) double-click www.

5. On the Local System screen (left side) use the icons to locate the 
file you want to upload.

6. Double-click the file you want to upload.

Website Account Maintenance

To access account information, perform email account maintenance, or 
to view statistics about the site you must log in to the website account via 
the Internet.Once logged in you can change or update account informa-
tion, add or delete email accounts, and view details of visitors to the site.

To log in to the account maintenance utility

1. Open your browser and go to www.netfirms.com.

2. Click Members.

3. Enter the account name: allpilgrims.org.

4. Enter the password: apcc509

5. Click Login.

From here you can choose a variety of options, the most common of 
which is adding or deleting email accounts.

To add an email account

1. Log in to the account maintenance utility.

2. Click E-mail.

3. Click Add an E-Mail Account.

4. Enter the requested information and click Submit.

To delete an email account

1. Log in to the account maintenance utility.

2. Click E-mail.

3. In the list of email accounts, locate the name of the account you 
want to delete and click Delete.

4. Click Yes to confirm.

For details on how to perform other tasks using the account maintenance 
utility, click Support on the Netfirms home page (www.netfirms.com).
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Troubleshooting Problems

Occasionally, visitors to the website report problems to the church office. 
Sometimes the problem is with the server or hosting service and some-
times it is an error that the Church Administrator can fix. The following 
table lists some common issues with the website.

Problem Possible Cause Solution

I can’t view the page 
I want.

There is a temporary 
problem with the 
server.

Try again later.

When I click a link, 
I get a “page not 
found error.”

There is a temporary 
problem with the 
server.

Try again later.

The link contains an 
error in its HTML.

Correct the code and 
upload the page to 
the server.

The page is not on 
the server.

Upload the page to 
the server.

I can’t access PDF 
files posted to the 
website.

You don’t have Acro-
bat Reader installed 
on your computer.

Go to 
www.adobe.com and 
download Acrobat 
Reader for free.

The PDF file has 
become corrupted.

Create a new PDF 
and upload it to the 
server.
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Publications
in this section

• Sunday Worship Bulletin

• Monthly Newsletter

• Membership Roster

• Meeting Minutes
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Sunday Worship Bulletin

The Sunday worship bulletin must be printed and folded before Sunday 
morning. The “worship prep team” (Co-Pastors, Music Director, and 
others) meet during the week to finalize the Order of Service. They may 
also provide information for announcements or for subsequent weeks' 
bulletins.

The bulletin is produced using Adobe InDesign. A template of the bulle-
tin is also available in Word format.

The Church Administrator’s role in producing the final bulletin is as fol-
lows:

1. Transfer the information from the worship prep team to the elec-
tronic document (InDesign or Word).

2. Proofread the electronic document for accuracy and correct any 
errors.

3. Email a copy to the worship prep team for them to review.

4. Incorporate any changes or additions you receive.

5. Print a master copy, proofread it for accuracy, and correct any 
errors.

6. Print desired number of copies on desired paper.

7. Fold copies and leave them in the office.

Monthly Newsletter

The Vine is the monthly newsletter of All Pilgrims Christian Church and 
is published at the beginning of the month. The Church Administrator is 
responsible for collecting submissions; laying out, proofreading, and 
publishing the document; and organizing a crew of volunteers to fold 
and mail it.

The deadline for submissions is the 15th of the month preceding (i.e. for 
the March newsletter, the deadline is February 15). You may extend this 
deadline for those who regularly contribute depending on the time you 
need to publish the document.It’s advisable to have the finished copies 
ready to mail three or four days before the end of the month.

The newsletter is produced using Adobe InDesign. For details on how to 
perform specific tasks using InDesign, please see the program documen-
tation.
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The Church Administrator’s role in producing the final newsletter is as 
follows:

1. Transfer submission information to the electronic document.

2. Proofread the electronic document for accuracy and correct any 
errors.

3. Email a copy to the designated review team.

4. Incorporate any changes or additions you receive.

5. Print a second copy, proofread it for accuracy, and correct any 
errors.

6. Print a color master copy at Kinko's or another local print shop.

7. Print desired number of copies using the office copier.

8. Organize a crew of volunteers to fold and mail the copies.

In addition to creating a hard copy newsletter, APCC also creates an 
online version that is posted on the website as a PDF file. For details on 
how to create a PDF file using InDesign, please see the program docu-
mentation.

Membership Roster

The membership roster lists all current members (regardless of status). 
their address, phone number, and email address. It is created using Ser-
vant Keeper, the church’s member database, and is distributed and 
printed from an Excel file. It’s advisable to update the roster every month 
as membership information changes frequently.

See the program documentation for Servant Keeper on how to create a 
CSV file of the group named “All Members Combined.” You import the 
CSV file into Excel where you can change formatting and add other fea-
tures.

To update the membership roster

1. Create a CSV file from Servant Keeper.

2. Open the folder Office/Membership.

3. Double-click membership_roster.xls. This is the most recent 
membership roster.

4. On the File menu, click Open.

5. Locate and double-click the CSV file to open it.

6. Cut and paste information from the CSV file to 
membership_roster.xls.

7. Format membership_roster.xls as necessary.

8. On the File menu, click Save.
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Meeting Minutes

The church office receives minutes from various committee meetings.
In addition to simply filing these minutes for reference, some committees 
ask to have them posted on the website so they can be reviewed. Minutes 
are received in electronic format, as either Word or Excel files.

To create Web files from meeting minutes

1. Double-click the document from which you want to create a 
Web file.

2. From the File menu, click Save As.

3. Type the desired name in the File Name box

4. From the File Type drop-down menu, click Web Page (HTML).

5. Click Save.

Once you have created the Web file, you must upload it to the server and 
change any pages that need to link to it. For details on how to do this, 
see “Adding, Updating, and Deleting Pages” on page19.
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Building Use Calendar

in this section

• Introduction

• Hard Copy Calendar

• Outlook Calendar
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Introduction

The Building Use Calendar is used to record church activities and tenant 
and one-time rentals. There are two versions of the Building Use Calen-
dar: hard copy and Outlook. If there is a discrepancy between the calen-
dars, the hard copy should be considered correct.

Hard Copy Calendar

The hard copy calendar is in a three-ring binder in the office. It is divided 
into months with a page for each day of the month. Each day list all rent-
able rooms in the building and divides them into three time zones: 8 am 
to noon; noon to 6 pm; 6 pm to 10 pm as illustrated below.

To add a date to the calendar, simply write the event and time in the 
appropriate day and room.

Note: It is imperative that the hard copy calendar is kept current as this is 
the primary source of building use information for other staff and com-
mittee members.

Outlook Calendar

The Outlook calendar is on the main office computer and can be viewed 
by opening Outlook. In addition to holding rental dates, it can also be 
used to record personal appointments, deadlines, and reminders.

To enter building use on the Outlook calendar

1. Open Outlook.

2. From the Outlook Shortcuts bar, click Calendar.

3. From the View menu, click Month.

4. Double-click the date on which you want to add an event.

5. Enter the event name in the Subject box.

6. Enter the room name in the Location  box.

7. Do one of the following:

• Select the All Day Event  box.

• Set the start and end times from the Start Time  and End 
Time  drop-down menus.

8. Add any additional information for the event.

9. Click Save and Close.
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Building Rentals

in this section

• Introduction

• Fielding Rental Inquiries

• Weddings and Commitment Ceremonies

• Discount Policy

• Fees and Regulations



Fo
r D

em
on

st
ra

tio
n 

Pu
rp

os
es

 O
nl

y



Fo
r D

em
on

st
ra

tio
n 

Pu
rp

os
es

 O
nl

y

Building Rentals | 35

Office Procedures

Introduction

APCC rents space to groups for a wide variety of activities, so long as the 
group's activity is in line with the church's mission. If you are unsure if a 
group is appropriate for renting space, consult the Pastors or the Building 
& Grounds Committee.

Fielding Rental Inquiries

Rentals to church groups
Church groups may rent any space for free if it is available. Depending 
on the type of event and the room(s) used, the group may be required to 
hire a Facilities Coordinator. If you are unsure about the requirements of 
an event requested by a church group, consult the Co-Pastors or the 
Building & Grounds Committee.

Rentals to outside groups 
By law, the church can only rent space to an outside group if they are a 
registered non-profit (individuals are considered non-profit). When field-
ing a call from a potential renter you should collect the following infor-
mation:

• Name and contact information of potential renter.

• Room(s) desired.

• Time(s) desired.

• Expected attendance for the event(s).

Weddings and Commitment Ceremonies

Weddings and commitment ceremonies constitute a large part of rentals 
at the church. For a detailed description of wedding and commitment 
ceremony policies, see the following document:

office/building use/wedding_policy.doc

Discount Policy

APCC has a discount policy that is designed to provide space to groups 
that may not otherwise be able to afford it. The policy also gives the 
church an opportunity to extend its hospitality in exchange for free pub-
licity. Groups can receive discounts if any of the following are true:

Category Discount

Registered non-profit in the state of Washington 25%

The event is free and open to the public. 20%

A church member is affiliated with the group 25%
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These requirements, if met, can be combined to provide a total discount 
of 70% from the published rental price. In addition, the Pastors and/or 
Coordinating Council can choose to offer a further discount.

Fees and Regulations

Fees for single use
The Building & Grounds Committee sets single-use rental fees. The 
prices listed below are for blocks of four hours and are the minimum 
charge for renting a space. Additional time can be purchased in blocks of 
two hours for the pro-rated amount.

• e.g. six hours in the Sanctuary costs $350 + ($350 / 2) = $525

All renters are required to pay a damage deposit unless they have made 
other arrangements with the church office or the Building and Grounds 
Committee.

* For every rental of the Sanctuary or Stuart Hall, the renter must also 
hire a Facilities Coordinator. See below for more information.

Fees for ongoing use
The Building and Grounds Committee sets prices for ongoing use and 
must approve all requests. The monthly rental fee is negotiated on a case-
by-case basis and is determined by the room(s) requested and the fre-
quency of use. Ongoing use rentals also require a damage deposit.

Room Rental Fee Damage Deposit

Sanctuary* $350 $250

Stuart Hall* $500 $450

Kitchen $150 $50

Weld Room $80 $50

Colonial Room $80 $50

Dickson Room $80 $50

Lewis Hall $80 $50
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Regulations
The following regulations apply to all rentals:

1. The church building closes promptly at 10 pm, Monday through 
Saturday, unless other arrangements have been made. 

2. There is no smoking in the church building or within 10 feet of 
any entrance.

3. Alcoholic beverages are not to be served or consumed on the 
church premises, unless approved by the Building & Grounds 
Committee.

4. Applicant may use only the room(s) specified in their Building 
Use Agreement, only for the time specified, and only for the 
purpose indicated.

5. Applicant is responsible for cleaning up after the event. This 
includes placing garbage in appropriate receptacles, ensuring 
floors and surfaces are free from excess dirt, and replacing furni-
ture to its original position.

6. The applicant may post a notice of activity location on the bulle-
tin board provided for that purpose inside the 10th Avenue East 
door. A sign may never be placed on our Broadway reader board 
without permission from the church office.

7. When using the kitchen, the tenant must wash, dry, and put 
away all plates, cup, utensils, etc. that are used.

8. Damage deposits will be deposited in the account of Pilgrim 
Congregational Church (UCC). Reimbursement will be issued 
in full only if all items above are satisfactorily adhered to before, 
during, and after the event.

Facilities Coordinator
Groups renting Stuart Hall or the Sanctuary must also hire a Facilities 
Coordinator. The Facilities Coordinator is someone appointed by the 
church to unlock and lock rented spaces, help find supplies, and answer 
your questions about usage. For weddings and commitment ceremonies, 
renters should direct their caterer, florist, musicians, and other help to the 
Facilities Coordinator for assistance.

The minimum cost for the Facilities Coordinator is $100 for a block of 
four hours. Additional hours can be purchased at $25 per hour.It is the 
renter’s responsible to coordinate with the Facilities Coordinator when 
he/she should be available.
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Appendices
In this section

• Appendix A: Recurring Office Tasks

• Appendix B: Where to Find Important Documents
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Appendix A: Recurring Office Tasks

This appendix lists common tasks the Church Administrator must per-
form on daily, weekly, and monthly basis.

Daily tasks

• Respond to email and voicemail messages.

• Post the building use schedule for the following day(s).

Weekly tasks

• Follow up with the Caretaker regarding the past weekend's 
activities.

• Mail checks signed by the Treasurer.

• Update website calendar.

• Process checks for the Treasurer to sign.

• Print and fold Sunday worship bulletin.

Monthly tasks

• Process payroll liability checks.

• Print monthly newsletter and organize a folding crew.

• Update the coming month's building calendar.

• Update the membership roster.

This list is intended as an example only and is not exhaustive. Many fac-
tors determine the need for these and other tasks. These factors may also 
dictate the Church Administrator’s ability to perform the tasks.
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Appendix B: Where to Find Important Documents

This appendix list the location of important electronic documents refer-
enced in this manual as well as other useful documents.

Building Use Agreement
office/building use/contract_template.doc

Frequently used numbers
office/labels and lists/lists/fun.doc

Example voicemail greeting
office/documentation/phone_greeting.doc

Servant Keeper manual
office/procedures/sk/sk_manual.pdf

Website server information
office/design/website/apcc/work files/setup.txt

Wedding and commitment policy(s)
office/building use/wedding_policy.doc




